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Bµi 1 :       c¬ së lý thuyÕt cña c¸c ph−¬ng ph¸p 
              tÝnh æN §ÞNH M¸I DèC TH¦êNG DïNG 

1. më ®Çu : 
 M¸i dèc lµ khèi ®Êt cã mÆt giíi h¹n lµ mÆt dèc (h×nh 1.1). M¸i dèc ®−îc 
h×nh thµnh hoÆc do t¸c nh©n tù nhiªn ( s−ên nói,bê s«ng .v.v..) hoÆc do t¸c ®éng 
nh©n t¹o ( vÝ dô : taluy nÒn ®−êng ®µo, nÒn ®¾p, hè mãng, th©n ®Ëp ®Êt, ®ª.v.v..). 

 
 
 
 
 
 
 

 TÊt c¶ c¸c m¸i dèc ®Òu cã xu h−íng gi¶m ®é dèc ®Õn mét d¹ng æn ®Þnh h¬n, 
cuèi cïng chuyÓn sang n»m ngang vµ trong bèi c¶nh nµy,  mÊt æn ®Þnh ®−îc quan 
niÖm lµ khi cã xu h−íng di chuyÓn vµ ph¸ ho¹i. §èi víi nÒn ®−êng ®µo lµ do khi 
chän kÝch th−íc, h×nh d¹ng cña m¸i dèc ch−a hîp lý. C¸c lùc g©y mÊt æn ®Þnh liªn 
quan chñ yÕu víi träng lùc vµ thÊm trong khi søc chèng ph¸ ho¹i c¬ b¶n lµ do h×nh 
d¹ng m¸i dèc kÕt hîp víi b¶n th©n ®é bÒn kh¸ng c¾t cña ®Êt vµ ®¸ t¹o nªn, do ®ã 
khi tÝnh to¸n æn ®Þnh cña m¸i dèc cÇn ph¶i xÐt ®Õn ®Çy ®ñ c¸c néi lùc vµ ngo¹i lùc. 
 Nh− chóng ta ®· biÕt m¸i dèc cµng tho¶i th× ®é æn ®Þnh sÏ cµng cao, nh−ng 
khèi l−îng c«ng t¸c ®Êt, diÖn tÝch chiÕm dông sÏ cµng lín, ®iÒu nµy sÏ dÉn ®Õn tr¸i 
víi quan ®iÓm kinh tÕ hiÖn nay. V× vËy, môc tiªu cuèi cïng cña viÖc tÝnh to¸n æn 
®Þnh m¸i dèc lµ x¸c ®Þnh ®−îc ®é dèc m¸i taluy tho· m·n yªu cÇu kinh tÕ vµ kü 
thuËt. 
 §Ó ®¸nh gi¸ æn ®Þnh cña m¸i dèc, vÒ mÆt lý thuyÕt hiÖn nay tån t¹i nhiÒu 
ph−¬ng ph¸p tÝnh, nh−ng cã thÓ gép chóng thµnh hai nhãm ph−¬ng ph¸p chÝnh nh− 
sau: 
          + Nhãm ph−¬ng ph¸p theo lý thuyÕt c©n b»ng giíi h¹n cña khèi r¾n ( gi¶ 
thiÕt tr−íc h×nh d¹ng cña mÆt tr−ît ) :      
 §Æc ®iÓm cña nhãm ph−¬ng ph¸p dïng mÆt tr−ît gi¶ ®Þnh lµ kh«ng c¨n cø 
trùc tiÕp vµo t×nh h×nh cô thÓ cña t¶i träng vµ tÝnh chÊt c¬ lý cña ®Êt ®¾p ®Ó quy 
®Þnh mÆt tr−ît cho m¸i dèc, mµ xuÊt ph¸t tõ kÕt qu¶ quan tr¾c l©u dµi c¸c mÆt tr−ît 
cña m¸i dèc trong thùc tÕ ®Ó ®−a ra gi¶ thiÕt ®¬n gi¶n ho¸ vÒ h×nh d¹ng mÆt tr−ît 
råi tõ ®ã nªu lªn ph−¬ng ph¸p tÝnh to¸n, ®ång thêi xem khèi tr−ît nh− lµ mét vËt 
thÓ r¾n ë tr¹ng th¸i c©n b»ng giíi h¹n. 
      + Nhãm ph−¬ng ph¸p dùa vµo lý thuyÕt c©n b»ng giíi h¹n thuÇn tuý :     
 Nhãm lý thuyÕt nµy dùa trªn gi¶ thuyÕt chÝnh cho r»ng, t¹i mçi ®iÓm trong 

   H×nh 1.1 : MÆt c¾t ngang mét m¸i dèc
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khèi ®¾p ®Êt ®Òu tho¶ m·n ®iÒu kiÖn c©n b»ng giíi h¹n. ViÖc mét ®iÓm mÊt æn ®Þnh 
®−îc gi¶i thÝch lµ do sù xuÊt hiÖn biÕn d¹ng tr−ît t¹i ®iÓm ®ã. Cßn m¸i ®Êt mÊt æn 
®Þnh lµ do sù ph¸t triÓn cña biÕn d¹ng tr−ît trong mét vïng réng lín giíi h¹n cña 
khèi ®Êt ®¾p. 

Trong hai nhãm ph−¬ng ph¸p nªu trªn, "nhãm ph−¬ng ph¸p dùa vµo lý 
thuyÕt c©n b»ng giíi h¹n thuÇn tuý " vÉn m« pháng ®−îc gÇn ®óng tr¹ng th¸i øng 
suÊt trong khèi ®Êt bÞ ph¸ ho¹i, vÒ mÆt to¸n häc mang tÝnh logic cao, nh−ng ®iÓm 
h¹n chÕ lµ ch−a xÐt ®−îc biÕn d¹ng thÓ tÝch cña khèi ®Êt, ®ång thêi lµ gi¶i bµi to¸n 
æn ®Þnh cña m¸i dèc theo ph−¬ng ph¸p nµy ch−a ®−îc ¸p dông réng r·i trong thùc 
tÕ. Nhãm ph−¬ng ph¸p "dïng mÆt tr−ît gi¶ ®Þnh " tuy cã nh−îc ®iÓm lµ xem khèi 
tr−ît nh− lµ mét cè thÓ vµ ®−îc giíi h¹n bëi mÆt tr−ît vµ mÆt m¸i dèc, ®ång thêi 
xem tr¹ng th¸i øng suÊt giíi h¹n chØ x¶y ra trªn mÆt tr−ît mµ th«i, thùc tÕ th× mÆt 
tr−ît x¶y ra rÊt phøc t¹p, phô thuéc vµo sù t¸c dông cña t¶i träng ngoµi, vµo tÝnh 
chÊt cña c¸c ®Þa tÇng vµ vµo c¸c yÕu tè kh¸c. Tuy vËy tuú theo t×nh h×nh cô thÓ cña 
tõng c«ng tr×nh, mµ viÖc gi¶ ®Þnh tr−íc c¸c mÆt tr−ît cho phï hîp, ®ång thêi nhãm 
ph−¬ng ph¸p nµy tÝnh to¸n ®¬n gi¶n h¬n vµ thiªn vÒ an toµn h¬n so víi nhãm 
ph−¬ng ph¸p lý luËn c©n b»ng giíi h¹n. ChÝnh v× thÕ thùc tÕ hiÖn nay sö dông 
ph−¬ng ph¸p nµy ®Ó tÝnh to¸n æn ®Þnh m¸i dèc ®−îc ¸p dông réng r·i h¬n. 

 
1.2 . ph−¬ng tr×nh c©n b»ng cña khèi ®Êt tr−ît 
1.2.1. C¸c gi¶ thiÕt tÝnh to¸n  

§Ó lËp ph−¬ng tr×nh c©n b»ng giíi h¹n cña khèi ®Êt tr−ît c¸c t¸c gi¶ nh− 
K.E.Pettecx¬n, W. Fellenius, Bishop, Sokolovski, K. Terzaghi ®Òu dùa vµo c«ng thøc næi 
tiÕng cña A.C. Coulomb ( §Þnh luËt Mohr - Coulomb - xem C¬ häc ®Êt ) ®Ó x¸c ®Þnh øng 

suÊt c¾t :     ns c tgσ ϕ= +      (1.1) 

 HoÆc    ( )ns c u tgσ ϕ= + −     (1.2) 

Trong ®ã :  

s - øng suÊt c¾t giíi h¹n t¹i ®iÓm bÊt kú trªn mÆt tr−ît ë tr¹ng th¸i c©n 
b»ng giíi h¹n. 

σn- øng suÊt ph¸p giíi h¹n ( vu«ng gãc víi mÆt tr−ît ) ë tr¹ng th¸i c©n 
b»ng giíi h¹n . 
c - Lùc dÝnh ®¬n vÞ cña ®Êt ë tr¹ng th¸i giíi h¹n øng víi hÖ sè æn ®Þnh 
cña m¸i dèc. 

  ϕ - Gãc ma s¸t trong cña ®Êt øng víi tr¹ng th¸i giíi h¹n cña ®Êt. 

  u - ¸p lùc n−íc lç rçng.  
 Khi tÝnh to¸n ®é æn ®Þnh, mÆt tr−ît gi¶ ®Þnh tr−íc cã thÓ lµ trßn, hçn hîp ( tæ 
hîp c¸c cung tr−ît trßn vµ th¼ng ) hoÆc h×nh d¹ng bÊt kú ®−îc x¸c ®Þnh bëi hµng 
lo¹t nh÷ng ®−êng th¼ng. Chia khèi ®Êt tr−ît ra thµnh nhiÒu cét th¼ng ®øng, mçi cét 
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®Êt ®−îc giíi h¹n bëi hai mÆt ph¼ng th¼ng ®øng vµ ®−îc xem nh− mét vËt r¾n 
nguyªn khèi tùa lªn trªn cung tr−ît. §iÓm kh¸c nhau c¬ b¶n gi÷a c¸c ph−¬ng ph¸p 
cña c¸c t¸c gi¶ nªu trªn chÝnh lµ viÖc gi¶ thiÕt ph−¬ng, vÞ trÝ t¸c dông vµ gi¸ trÞ cña 
c¸c lùc t¸c dông t−¬ng hç gi÷a c¸c m¶nh tr−ît bao gåm lùc c¾t vµ lùc x« ngang 
gi÷a c¸c m¶nh. 
 Ph−¬ng tr×nh c©n b»ng giíi h¹n ®−îc x¸c ®Þnh dùa trªn c¸c gi¶ thiÕt : 
 + §Êt ®−îc xem nh− vËt liÖu tu©n theo ®Þnh luËt Mohr - Coulomb. 
 + HÖ sè æn ®Þnh ( hÖ sè an toµn ) nh− nhau cho tÊt c¶ c¸c ®iÓm trªn mÆt 
tr−ît.  

+ Tr¹ng th¸i c©n b»ng giíi h¹n chØ x¶y ra trªn mÆt tr−ît. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

H×nh 1.2 : Lùc t¸c dông lªn ph©n tè ®Êt trong  
tr−êng hîp mÆt tr−ît trßn 

H×nh 1.3 : Lùc t¸c dông lªn ph©n tè ®Êt trong    
tr−êng hîp mÆt tr−ît tæ hîp 
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H×nh (1.2), (1.3) vµ (1.4)  thÓ hiÖn c¸c h×nh d¸ng mÆt tr−ît. C¸c gi¸ trÞ ®−îc 

®Þnh nghÜa nh− sau : 
W - Träng l−îng cña m¶nh tr−ît víi bÒ réng b vµ chiÒu cao trung b×nh h. 
N - Tæng lùc ph¸p tuyÕn t¹i ®¸y mÆt tr−ît cña ph©n tè ®Êt. 
S - Lùc c¾t di chuyÓn ( lùc c¾t ho¹t ®éng ) t¹i ®¸y mÆt tr−ît cña ph©n tè ®Êt, 

hoÆc lµ Sm khi mÆt tr−ît cã h×nh d¹ng bÊt kú. 
EL, ER - Lùc ph¸p tuyÕn bªn tr¸i vµ bªn ph¶i cña mçi ph©n tè ®Êt. 
XL, XR - Lùc c¾t bªn tr¸i vµ bªn ph¶i cña mçi ph©n tè ®Êt. 
D - Ngo¹i lùc t¸c dông. 
kW - T¶i träng ®éng ®Êt theo ph−¬ng ngang t¸c dông ®i qua träng t©m mçi 

ph©n tè ®Êt. 
R - B¸n kÝnh mÆt tr−ît trßn hay c¸nh tay ®ßn cña lùc c¾t di chuyÓn, Sm khi 

mÆt tr−ît cã h×nh d¹ng bÊt kú. 
f - kho¶ng c¸ch tõ t©m quay ®Õn ph−¬ng cña lùc ph¸p tuyÕn N. 
x - Kho¶ng c¸ch theo ph−¬ng ngang tõ ®−êng träng t©m cña mçi ph©n tè ®Êt 

®Õn t©m cung tr−ît trßn hay t©m m«men ( khi cung tr−ît cã h×nh d¹ng bÊt kú ). 
e - Kho¶ng c¸ch theo ph−¬ng ®øng tõ t©m cña mçi ph©n tè ®Êt ®Õn t©m cung 

tr−ît trßn hay t©m m«men ( khi cung tr−ît cã h×nh d¹ng bÊt kú ). 
d - Kho¶ng c¸ch vu«ng gãc tõ ®−êng t¸c dông cña t¶i träng ngoµi ®Õn t©m 

cung tr−ît trßn hay t©m m«men. 
h - ChiÒu cao trung b×nh cña mçi ph©n tè ®Êt. 
b - ChiÒu réng theo ph−¬ng ngang cña mçi ph©n tè ®Êt. 

β - ChiÒu dµi ®¸y mÆt tr−ît. 
a - Kho¶ng c¸ch tõ hîp lùc n−íc bªn ngoµi ( n−íc ngËp hai bªn taluy ) tíi 

t©m quay hay t©m m«men. 
AL, AR - Hîp lùc t¸c dông cña n−íc. 

H×nh 1.4 : Lùc t¸c dông lªn ph©n tè ®Êt trong   
tr−êng hîp mÆt tr−ît g·y khóc 
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ω - gãc nghiªng cña ®−êng t¶i träng ngoµi so víi ph−¬ng ngang. 

α - Gãc hîp gi÷a tiÕp tuyÕn t¹i ®¸y mçi mÆt tr−ît víi ph−¬ng n»m ngang. 
HÖ sè æn ®Þnh cña m¸i dèc cã thÓ ®−îc x¸c ®Þnh tõ ®iÒu kiÖn c©n b»ng 

m«men hoÆc c©n b»ng lùc hoÆc ®iÒu kiÖn c©n b»ng giíi h¹n tæng qu¸t. 
 

1.2.2. Ph−¬ng tr×nh c©n b»ng m«men   
 §iÒu kiÖn c©n b»ng giíi h¹n vÒ m«men lµ tæng m«men cña c¸c lùc ®èi víi 
t©m tr−ît ph¶i b»ng kh«ng ( xem h×nh 1.2, 1.3 vµ 1.4 ):  

  . . .f . . . 0mW x S R N kW e D d A a− − + ± ± =∑ ∑ ∑ ∑    (1.3) 
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 Trong ®ã : 

   
[ ( ) ]. n

m
m m

c u tgsS
K K

β σ ϕβ + −
= =      (1.5) 

  Víi : 

   n
Nσ
β

= - øng suÊt ph¸p trung b×nh t¹i ®¸y mÆt tr−ît. 

   Km - HÖ sè æn ®Þnh x¸c ®Þnh theo ®iÒu kiÖn c©n b»ng vÒ m«men. 
   s ®−îc x¸c ®Þnh tõ c«ng thøc (1.1) hay (1.2) 

 
1.2.3. Ph−¬ng tr×nh c©n b»ng lùc   
 §iÒu kiÖn c©n b»ng lùc theo ph−¬ng ngang cho tÊt c¶ c¸c m¶nh tr−ît ( xem 
h×nh 1.2, 1.3 vµ 1.4 ):  
   ( ) .sin .cos .cos 0L R mE E N S kW D Aα α α− − + − − ± =∑ ∑ ∑ ∑   (1.6) 
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1.2.4. Ph−¬ng tr×nh c©n b»ng giíi h¹n tæng qu¸t (GLE) 
 Trong thùc tÕ, t×nh h×nh ph©n bè ®Þa chÊt, thuû v¨n rÊt phøc t¹p ë c¸c m¸i dèc nÒn 
®µo, nªn mÆt tr−ît còng th−êng cã h×nh d¹ng rÊt phøc t¹p : cã thÓ lµ hçn hîp c¸c cung  
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trßn vµ c¸c ®o¹n th¼ng hoÆc c¸c ®o¹n th¼ng g·y khóc. Do vËy tån t¹i t©m tr−ît ¶o, sè 
l−îng Èn lín h¬n sè c¸c ph−¬ng tr×nh ®−îc lËp, bµi to¸n trë nªn v« ®Þnh. NÕu gi¶ thiÕt mét 
t©m tr−ît ®Ó tho¶ m·n ®iÒu kiÖn c©n b»ng m«men, th× kh«ng tho¶ m·n ®iÒu kiÖn c©n b»ng 
vÒ lùc theo mét ph−¬ng nµo ®ã, hoÆc ng−îc l¹i. Do vËy, mét sè t¸c gi¶ kÕt hîp c¸c ®iÒu 
kiÖn c©n b»ng trªn ®Ó gi¶i quyÕt bµi to¸n - §−îc gäi lµ ph−¬ng ph¸p c©n b»ng giíi h¹n 
tæng qu¸t ( General Limit Equilibrium - GLE ), sö dông c¸c ph−¬ng tr×nh c©n b»ng tÜnh 
häc sau ®©y ®Ó t×m hÖ sè an toµn : 
 1- Tæng c¸c lùc theo ph−¬ng ®øng ®èi víi ph©n tè ®Êt ®−îc gi¶ ®Þnh ®Ó t×m lùc 
ph¸p tuyÕn N t¹i ®¸y mÆt tr−ît. 

  ( ) .cos .sin .sin 0L R mW X X N S Dα α α− + − + + − =    (1.8) 

 Thay (1.1) hay (1.2) vµo (1.8) gi¶i ®−îc ph¶n lùc ph¸p tuyÕn N : 

  

. .sin . .sin .( ) .sin

sin .cos

R L
c u tgW X X D

KN tg
K

β α β α ϕ α

α ϕα

+
+ − − +

=
+

  (1.9) 

 2- Tæng c¸c lùc theo ph−¬ng ngang ®èi víi mçi mÆt tr−ît ®−îc sö dông ®Ó tÝnh 
to¸n lùc t−¬ng hç E. Ph−¬ng tr×nh ®−îc ¸p dông khi tÝnh tÝch ph©n toµn bé khèi l−îng 
khèi tr−ît tõ tr¸i sang ph¶i. 
 3- Tæng momen ®èi víi mét ®iÓm chung cho tÊt c¶ c¸c ph©n tè ®Êt, dïng ®Ó tÝnh 
hÖ sè æn ®Þnh momen Km. 
 4- Tæng c¸c lùc theo ph−¬ng ngang ®èi víi tÊt c¶ c¸c l¸t c¾t, dïng ®Ó tÝnh hÖ sè æn 
®Þnh Kf. 
 KÕt qu¶ lµ hÖ sè æn ®Þnh chung K ®−îc tÝnh trªn c¸c hÖ sè æn ®Þnh Km vµ Kf, tøc lµ 
tho¶ m·n c¶ ®iÒu kiÖn c©n b»ng lùc vµ c©n b»ng momen, vµ ®−îc xem lµ hÖ sè æn ®Þnh     
( hÖ sè an toµn ) héi tô cña ph−¬ng ph¸p c©n b»ng giíi h¹n tæng qu¸t.  
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CH¦¥NG II 

øng dông phÇn mÒm Slope/w tÝnh æn ®Þnh m¸i dèc 
 
2.1. Giíi thiÖu mét sè phÇn mÒm tÝnh æn ®Þnh m¸i dèc hiÖn nay 

- PhÇn mÒm Taren (Ph¸p) : TÝnh æn ®Þnh m¸i dèc, t−êng ch¾n cã gia c−êng 
neo thÐp. 

- PhÇn mÒm tæng hîp Plaxis (Hµ Lan) : Dùa vµo lý thuyÕt c©n b»ng giíi 
h¹n thuÇn tuý, gi¶i quyÕt bµi to¸n b»ng ph−¬ng ph¸p phÇn tö h÷u h¹n - 
m« h×nh chuyÓn vÞ. PhÇn mÒm tÝnh to¸n æn ®Þnh m¸i dèc, t−êng ch¾n gia 
c−êng neo thÐp, l−íi v¶i ®Þa kü thuËt, l−íi cèt thÐp, ... 

- Bé phÇn mÒm Geo - Slope (Canada) : ®−îc nhiÒu n−íc trªn thÕ giíi ®¸nh 
gi¸ lµ bé ch−¬ng tr×nh m¹nh nhÊt, ®−îc dïng phæ biÕn nhÊt hiÖn nay, gåm 
cã 6 Modul sau : 
1. SEEP/W : Ph©n tÝch thÊm. 
2. SIGMA/W : Ph©n tÝch øng suÊt biÕn d¹ng. 
3. SLOPE/W : Ph©n tÝch æn ®Þnh m¸i dèc, m¸i dèc cã gia c−êng neo. 
4. CTRAIN/W : Ph©n tÝch « nhiÔm trong giao th«ng. 
5. TEMP/W : Ph©n tÝch ®Þa nhiÖt. 
6. QUAKE/W : Ph©n tÝch ®ång thêi c¸c thµnh phÇn trªn. 

2.2. Giíi thiÖu phÇn mÒm SLOPE/W 
Trong phÇn nµy chØ giíi thiÖu mét sè vÊn ®Ò chÝnh cña phÇn mÒm Slope/w 

version 4.2, cã thÓ xem thªm h−íng dÉn chi tiÕt c¸c lÖnh b»ng menu Help trong 
ch−¬ng tr×nh. 

 
2.2.1. Mµn h×nh lµm viÖc cña phÇn mÒm Slope/w 

- Cöa sæ chÝnh ( main window ) : Gièng nh− bÊt kú ch−¬ng tr×nh ch¹y 
trong m«i tr−êng windows kh¸c, cöa sæ chÝnh cña Slope/w còng bao gåm 
c¸c thµnh phÇn sau : thanh tiªu ®Ò chøa tªn ch−¬ng tr×nh vµ tªn tÖp ®ang 
më, c¸c nót ®iÒu khiÓn maximize, minimize, close, menu bar, c¸c thanh 
c«ng cô, thanh tr¹ng th¸i, vïng ®å ho¹, ... cã tªn lµ DEFINE. 

Tõ cöa sæ chÝnh më ®Õn 2 cöa sæ con thÓ hiÖn kÕt qu¶ tÝnh to¸n cã tªn 
lµ CONTOUR vµ SOLVE. 

 
- Thanh menu bar ( Bar menu ): Chøa tÊt c¶ c¸c lÖnh cã thÓ thùc hiÖn 

víi Slope/w : 
 
 

 



Tr−êng §HBK - Bé m«n §−êng «t« & §−êng thµnh phè  8 

H−íng dÉn sö dông phÇn mÒm kiÓm tra æn ®Þnh m¸i dèc Slope/W  

Cöa sæ ph©n tÝch æn ®Þnh m¸i dèc

T©m tr−ît 

mÆt tr−ît

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Thanh tiªu ®Ò menu bar
c¸c thanh c«ng cô 

mµn h×nh ®å ho¹

To¹ ®é con trá

Trôc to¹ ®é  

Thanh tr¹ng th¸i 

Thanh cuén 

Cöa sæ chÝnh cña ch−¬ng tr×nh



Tr−êng §HBK - Bé m«n §−êng «t« & §−êng thµnh phè  9 

H−íng dÉn sö dông phÇn mÒm kiÓm tra æn ®Þnh m¸i dèc Slope/W  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- Thanh c«ng cô chuÈn ( Standard toolbar ) : Cung cÊp nhanh c¸c lÖnh c¬ 

b¶n, thao t¸c vµo, ra, quan s¸t m« h×nh ... 
 
 
 
- C¸c thanh c«ng cô næi ( floalting toolbar ) : Cung cÊp nhanh c¸c lÖnh t¹o m« 

h×nh, thay ®æi m« h×nh, chän ph−¬ng ph¸p ph©n tÝch, chØnh söa vµ xem kÕt qu¶. 
 
 
 
- Cöa sæ hiÓn thÞ m« h×nh ( Dislay window ) : Dïng ®Ó ®å ho¹ c¸c s¬ ®å h×nh 

häc, hiÖn thÞ kÕt qu¶ ph©n tÝch, gåm cã 2 cöa sæ Define vµ Contour. ë mçi thêi 
®iÓm chØ cã mét cöa sæ ho¹t ®éng 

- Thanh tr¹ng th¸i ( Status bar ) : ThÓ hiÖn th«ng tin hiÖn thêi cña m« h×nh 
nh− vÞ trÝ trá chuét trªn mµn h×nh hiÓn thÞ, lÖnh ®ang thùc thi ... 

 

2.2.2. M« t¶ c¸c menu c¬ b¶n 
1. File MENU :  

 Chøa c¸c lÖnh vÒ file, kÕt xuÊt d÷ liÖu, in Ên. 
 
 
 
 
 

Cöa sæ lÆp tÝnh æn ®Þnh m¸i dèc

Nót khëi ®éng 

Nót dõng

Ph−¬ng ph¸p 
ph©n tÝch 

HÖ sè æn ®Þnh 
theo ®iÒu kiÖn 

c©n b»ng 
momen 

Sè lÇn lÆp 

HÖ sè æn ®Þnh 
theo ®iÒu kiÖn 
c©n b»ng lùc 
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-> Më mét file míi 
-> Më mét file ®· cã 
-> §äc file d÷ liÖu tõ c¸c modul cña Geoslope 
-> XuÊt d÷ liÖu d¹ng file *.emf  
-> ghi d÷ liÖu thµnh file 
 
 
-> In h×nh ®å ho¹ 
 
 
 
-> C¸c file võa thùc thi  
 
 
 
 
-> Tho¸t khái ch−¬ng tr×nh Slope/w 
 

 

2. File SET :  
 
 
 
 
 

 
 

3. File SET :  
 
 
 
 
 
 
 

 

4. File SET :  
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 Bµi 2 : øng dông phÇn mÒm Slope/W ®Ó gi¶i         
     quyÕt bµi to¸n æn ®Þnh m¸i dèc 

 
A. KIÓM TRA æn ®Þnh m¸i dèc : 

I. ThiÕt lËp vïng lµm viÖc : 

 Vïng lµm viÖc lµ n¬i sö dông cho viÖc ®Þnh nghÜa bµi to¸n, cã thÓ nhá h¬n, 

b»ng hoÆc lín h¬n trang giÊy in. 

 NÕu vïng lµm viÖc lín h¬n trang giÊy in, bµi to¸n sÏ ®−îc in trªn nhiÒu trang 

khi hÖ sè phãng b»ng hoÆc lín h¬n 1. 

 Vïng lµm viÖc nªn ®−îc thiÕt lËp tr−íc ®Ó t¹o thuËn lîi cho viÖc thao t¸c víi 

mét tû lÖ quen thuéc. Th«ng th−êng cã thÓ chän kÝch th−íc vïng lµm viÖc : Réng 

260 mm, Cao 200 mm. 

I.1 X¸c ®Þnh ph¹m vi vïng lµm viÖc : 

- Tõ thùc ®¬n Set chän trang Page. XuÊt hiÖn hép tho¹i nh− h×nh vÏ : 

 

- Chän ®¬n vÞ ¸p dông cho vïng lµm viÖc trong hép nhãm Units lµ mm 

- Trong nhãm Working Area, chän Width = 260 mm, Height = 200 mm 

- Chän OK. 

I.2 X¸c ®Þnh tû lÖ vÏ : 

 C¸c ®èi t−îng h×nh häc th«ng th−êng ®−îc ®Þnh nghÜa víi ®¬n vÞ m, do ®ã 

cÇn chän tû lÖ vÏ thÝch hîp ®Ó phï hîp víi néi dung trang giÊy (th−êng ®−îc chän 

lµ 1:200 ) 

- Tõ thùc ®¬n Set chän trang Scale. XuÊt hiÖn hép tho¹i nh− h×nh vÏ : 
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- Chän ®¬n vÞ dïng ®Ó miªu t¶ ®èi t−îng h×nh häc trong nhãm Engineering 

Units lµ Meters 

- NhËp kÝch th−íc më réng dïng ®Ó miªu t¶ bµi to¸n trong nhãm Problem 

Extents, nªn chän kÝch th−íc réng h¬n bµi to¸n mét chót ®Ó cã thÓ dµnh lÒ cho b¶n 

vÏ. 

- NhËp tû lÖ vÏ trong hép Horz.1 vµ Vert.1 trong nhãm Scale. 

L−u ý : Khi nhËp tû lÖ vÏ míi, kÝch th−íc vïng lµm viÖc cã thÓ thay ®æi theo 

tû lÖ míi th«ng qua sù thay ®æi cña c¸c gi¸ trÞ Maximum x vµ Maximum y trong 

nhãm Problem Extents. 

- Chän OK. 

I.3 X¸c ®Þnh l−íi vÏ : 

 ViÖc x¸c ®Þnh nÒn l−íi vÏ trong ph¹m vi vïng lµm viÖc sÏ t¹o ®iÒu kiÖn 

thuËn lîi cho viÖc t¹o ®iÓm, ®−êng chÝnh x¸c theo to¹ ®é mong muèn th«ng qua 

chÕ ®é “b¾t dÝnh”. 

 - Tõ thùc ®¬n Set chän trang Grid. XuÊt hiÖn hép tho¹i nh− h×nh vÏ : 
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 - NhËp kho¶ng c¸ch l−íi trong hép X vµ Y trong nhãm Grid Spacing. Sau 

khi nhËp, kho¶ng c¸ch thùc cña m¾t l−íi trªn mµn h×nh ®−îc thÓ hiÖn trong nhãm 

Actual Grid Spacing. 

 - NhÊp chän trong « Display Grid vµ Snap to Grid 

 - Chän OK. 

I.4 L−u d÷ liÖu vµo tÖp : 

D÷ liÖu ®Þnh nghÜa cña bµi to¸n cÇn ®−îc ghi ra tÖp, nh¾m phôc vô cho c¸c 

ch−¬ng tr×nh SOLVE, CONTOUR gi¶i vµ hiÓn thÞ kÕt qu¶. 

- NÕu d÷ liÖu ®−îc ghi lÇn ®Çu vµ sau mçi lÇn thao t¸c, chän Save tõ thùc 

®¬n File 

- NÕu l−u d÷ liÖu vµo mét tÖp kh¸c, chän Save As tõ thùc ®¬n File. 

 

II. Ph¸c th¶o bµi to¸n : 

II.1 Ph¸c th¶o néi dung bµi to¸n : 

§Ó ph¸c th¶o bµi to¸n ®Çu tiªn cÇn lµm xuÊt hiÖn toµn bé vïng lµm viÖc 

trong cöa sæ mµn h×nh, b»ng viÖc nhÊn chuét lªn nót Zoom Page   trªn thanh 

c«ng cô Zoom  

§Ó ph¸c th¶o néi dung bµi to¸n chän Lines tõ thùc ®¬n Sketch, lóc nµy con 

trá chuét sÏ biÕn thµnh h×nh dÊu +, di chuyÓn con trá chuét ®Õn to¹ ®é ®iÓm cÇn 

ph¸c th¶o vµ nhÊn phÝm tr¸i, con trá chuét sÏ ®−îc dÞch chuyÓn ®Õn to¹ ®é ®iÓm 

mong muèn nhê c¬ chÕ “b¾t dÝnh”. Lóc nµy, nÕu tiÕp tôc di chuyÓn, mét ®−êng kÎ 

sÏ xuÊt hiÖn t¹i ®iÓm võa b¾t dÝnh ®Õn vÞ trÝ hiÖn t¹i cña chuét. Cø tiÕp tôc di 
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chuyÓn chuét vµ b¾t dÝnh c¸c ®iÓm mong muèn theo yªu cÇu cña bµi to¸n vµ kÕt 

thóc viÖc ph¸t th¶o b»ng phÝm ph¶i chuét. 

NhÊn nót Zoom Objects  trªn thanh c«ng cô Zoom ®Ó phãng to c¸c 

®−êng võa ph¸t th¶o võa khÝt víi cöa sæ vïng lµm viÖc. 

II.2 X¸c ®Þnh ph−¬ng ph¸p ph©n tÝch (Bishop, Ordinary, Janbu,..) 

- §Ó ph©n tÝch bµi to¸n æn ®Þnh m¸i dèc, hiÖn nay cã rÊt nhiÒu ph−¬ng ph¸p, 

®Ó chØ ra ph−¬ng ph¸p ph©n tÝch tõ thùc ®¬n KeyIn chän Analysis Method, sÏ xuÊt 

hiÖn hép tho¹i nh− h×nh vÏ : 

 

- Chän ph−¬ng ph¸p ph©n tÝch Bishop (with Ordinary & Janbu) 

- Chän OK. 

II.3X¸c ®Þnh c¸c tuú chän khi ph©n tÝch bµi to¸n. 

§Ó chØ ra c¸c tuú chän khi ph©n tÝch : 

- Tõ thùc ®¬n KeyIn chän Analysis Control, sÏ xuÊt hiÖn hép tho¹i : 
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- Trong hép tho¹i KeyIn Analysis Control, sö dông c¸c lùa chän mÆc ®Þnh 

nh− sau : 

+ Trong nhãm Apply Probability Analysis chän kh«ng ph©n tÝch x¸c suÊt 

(Probabilistic analysis) 

+ Trong nhãm Slip Surface Option lùa chän c¸c lo¹i mÆt tr−ît, nÕu lùa chän 

Grid and Radius cho phÐp ®Þnh râ mét l−íi c¸c t©m vµ b¸n kÝnh mÆt tr−ît. 

+ Lùa chän møc ®é héi tô, th«ng qua nhãm Convergence nhËp sè m¶nh cña 

mÆt tr−ît (Number of Slices) vµ sai sè cho phÐp. 

+ Lùa chän h−íng di chuyÓn cña mÆt tr−ît th«ng qua nhãm Direction of 

Movement 

+ Lùa chän c¸ch biÔu diÔn ¸p lùc n−íc mao dÉn b»ng ®−êng ¸p lùc 

Piezometric Lines/Ru trong nhãm Pore-Water Pressure  

+ Lùa chän ¶nh h−ëng cña søc c¨ng ®Õn viÖc xuÊt hiÖn vÕt nøt trong nhãm 

Tension crack lµ None. 

+ Chän OK. 

II.4 NhËp c¸c th«ng sè tÝnh to¸n cho nÒn ®Êt 

§Ó nhËp th«ng sè c¸c líp ®Êt, tõ thùc ®¬n KeyIn chän Soil Properties, sÏ 

xuÊt hiÖn hép tho¹i nh− h×nh vÏ : 
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Qu¸ tr×nh nhËp ®−îc tiÕn hµnh cho tõng líp, bao gåm c¸c th«ng sè : sè thø tù 

líp ®Êt (ë « soil), m« h×nh tÝnh to¸n (ë « Strength Model), miªu t¶ líp ®Êt (ë « 

Description), vµ chän mµu thÓ hiÖn (ë « Color).  

Sau khi ®· nhËp ®Çy ®ñ c¸c ®Æc tÝnh cho mçi líp ®Êt, nhÊn nót Copy ®Ó chÐp 

vµo danh s¸ch. Sau khi ®· nhËp ®Çy ®ñ c¸c líp ®Êt vµo « danh s¸ch nhÊp chän OK 

®Ó kÕt thóc. 

II.5 VÏ ®−êng ph©n c¸ch gi÷a c¸c líp ®Êt trªn b¶n vÏ ph¸c th¶o : 

§Ó vÏ ®−êng ph©n c¸ch gi÷a c¸c líp ®Êt trªn b¶n vÏ ph¸c th¶o (hay s¬ ®å 

h×nh häc cña líp ®Êt), sö dông lÖnh Draw Lines . TÊt c¶ c¸c ®−êng ph¶i b¾t ®Çu tõ 

®iÓm tr¸i nhÊt vµ kÕt thóc ë ®iÓm ph¶i nhÊt cho tõng líp. 

- §Çu tiªn tõ thùc ®¬n Draw chän lÖnh Lines, sÏ xuÊt hiÖn hép tho¹i Draw 

Lines nh− h×nh vÏ : 
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- Trong nhãm Select Line « Line # thÓ hiÖn sè thø tù líp ®Êt, mÆc ®Þnh lµ 1. 

Chän Draw ®Ó vÏ 

L−u ý : Khi chän Draw con trá chuét sÏ chuyÓn thµnh h×nh dÊu +, bÊm phÝm 

tr¸i chuét ®Ó nhÊp chän ®iÓm cÇn vÏ, nhÊp phÝm ph¶i hoÆc ESC ®Ó kÕt thóc qu¸ 

tr×nh vÏ, lóc nµy hép tho¹i Draw Lines l¹i xuÊt hiÖn ®Ó chän ®−êng vÏ cho líp ®Êt 

tiÕp theo. Chän sè thø tù líp ®Êt vµ lÖnh Draw ®Ó vÏ ®−êng tiÕp theo, hoÆc Done ®Ó 

kÕt thóc qu¸ tr×nh vÏ. 

II.6 VÏ ®−êng ph©n bè ¸p lùc n−íc lç rçng trong ®Êt : 

Slope/W thÓ hiÖn ph©n bè ¸p lùc n−íc lç rçng trong ®Êt b»ng mét ®−êng ®o 

¸p. 

§Ó vÏ ®−êng ®o ¸p, chän môc Pore Water Pressure tõ thùc ®¬n Draw, hép 

tho¹i Draw Piezometric Lines xuÊt hiÖn nh− h×nh vÏ : 

                                  

Trong nhãm Apply to Soil chän c¸c líp ®Êt cÇn vÏ ®−êng ®o ¸p. 

Chän lÖnh Draw ®Ó b¾t ®Çu vÏ ®−êng ®o ¸p, ®Ó nhÊp chän ®iÓm khi vÏ bÊm 

phÝm tr¸i chuét, ®Ó kÕt thóc lÖnh vÏ bÊm phÝm ph¶i chuét. Lóc nµy hép tho¹i Draw 

Piezometric Lines l¹i xuÊt hiÖn ®Ó vÏ ®−êng thø hai.  

§Ó kÕt thóc qu¸ tr×nh vÏ ®−êng ®o ¸p, nhÊn chän nót Done. 

II.7. X¸c ®Þnh b¸n kÝnh mÆt tr−ît vµ l−íi mÆt tr−ît 

 II.7.1 X¸c ®Þnh vïng b¸n kÝnh mÆt tr−ît : 

 §Ó x¸c ®Þnh b¸n kÝnh cung tr−ît vµ vÞ trÝ cña mÆt tr−ît thö nghiÖm, cÇn x¸c 

®Þnh vïng b¸n kÝnh mÆt tr−ît th«ng qua viÖc ®Þnh nghÜa c¸c ®−êng hoÆc c¸c ®iÓm 
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sö dông cho viÖc tÝnh to¸n b¸n kÝnh cung tr−ît (SLOPE/W sÏ ®Þnh nghÜa cung tr−ît 

b»ng c¸ch sö dông c¸c ®−êng nµy lµm tiÕp tuyÕn). 

 - Tõ thùc ®¬n Draw, chän Slip Surface > Radius, con trá chuét sÏ chuyÓn 

sang h×nh dÊu + vµ thanh tr¹ng th¸i xuÊt hiÖn chØ dÉn “Draw Slip Surface Radius”, 

tiÕn hµnh di chuyÓn chuét vµ x¸c ®Þnh vïng dïng ®Ó vÏ ®−êng b¸n kÝnh mÆt tr−ît. 

Sau khi chän, vïng dïng ®Ó vÏ ®−êng b¸n kÝnh sÏ ®−îc viÒn, vµ xuÊt hiÖn hép tho¹i 

Draw Slip Surface Radius nh− h×nh vÏ : 

                                

 

 Trong hép # of Radius Increments chÊp nhËn gi¸ trÞ mÆc ®Þnh 2. 

 - Chän OK 

 II.7.2. X¸c ®Þnh l−íi t©m tr−ît : 

 - T−¬ng tù c¸ch x¸c ®Þnh vïng b¸n kÝnh mÆt tr−ît, tõ thùc ®¬n Draw, chän 

Slip Surface > Grid, con trá chuét sÏ chuyÓn sang h×nh dÊu + vµ thanh tr¹ng th¸i 

xuÊt hiÖn chØ dÉn “Draw Slip Surface Grid”, tiÕn hµnh di chuyÓn chuét vµ x¸c ®Þnh 

vïng dïng ®Ó vÏ ®−êng b¸n kÝnh mÆt tr−ît. Sau khi chän, vïng l−íi t©m tr−ît sÏ 

®−îc vÏ bÞ ®¸nh dÊu. Hép tho¹i Draw Slip Surface Grid xuÊt hiÖn nh− h×nh vÏ : 

                            

 Trong nhãm # of Increments nhËp gi¸ trÞ ®Ó chia l−íi theo chiÒu ngang (X) 

vµ däc (Y) trong vïng l−íi t©m tr−ît. 

 - Chän OK hoÆc Apply. Lóc nµy trªn mµn h×nh l−íi t©m tr−ît gåm 12 ®iÓm. 

SLOPE/W SOLVE sÏ ®Þnh nghÜa cung tr−ît qua c¸c t©m ®iÓm nµy. 
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 II.8. Khai b¸o t¶i träng tËp trung : 

ViÖc khai b¸o t¶i träng tËp trung bao gåm viÖc x¸c ®Þnh vÞ trÝ, ®é lín vµ 

h−íng cña t¶i träng. 

- Tõ thùc ®¬n Draw, chän Line Loads, hép tho¹i Draw Line Loads xuÊt 

hiÖn : 

     

Con trá chuét chuyÓn sang h×nh dÊu + vµ thanh tr¹ng th¸i xuÊt hiÖn th«ng 

b¸o “Draw Line Loads” 

- Trong hép Magnitude nhËp gi¸ trÞ ®é lín cña t¶i träng 

- NÕu chän ph−¬ng ph¸p ph©n tÝch x¸c suÊt, trong « Standard Deviation 

nhËp gi¸ trÞ ®é lÖch chuÈn cña t¶i träng. 
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- Di chuyÓn con trá ®Õn vÞ trÝ cÇn ®Æt t¹i träng vµ nhÊn phÝm tr¸i. NÕu tiÕp 

tôc di chuyÓn con trá sÏ xuÊt hiÖn mét ®−êng mµu ®en tõ vÞ trÝ con trá. H−íng cña 

t¶i träng xuÊt hiÖn trong « Direction. 

- §Ó chØ chÝnh x¸c h−íng cña t¶i träng, cã thÓ nhËp trùc tiÕp gi¸ trÞ gãc cña 

t¶i träng trong « Direction (víi ®¬n vÞ nhËp lµ ®é – xem h×nh vÏ). 

 

 

- NhÊn nót Apply ®Ó x¸c nhËn khai b¸o. 

TiÕp tôc nhËp c¸c t¶i träng cßn l¹i theo c¸c b−íc ®· nªu. 

- NhÊn Done ®Ó kÕt thóc. 

II.9 HiÖu chØnh t¶i träng : 

- Tõ thùc ®¬n Draw, chän Line Loads, hép tho¹i Draw Line Loads xuÊt 

hiÖn : 

     

Con trá chuét chuyÓn sang h×nh dÊu + vµ thanh tr¹ng th¸i xuÊt hiÖn th«ng 

b¸o “Draw Line Loads” 

- Chän t¶i träng trªn b¶n vÏ cÇn hiÖu chØnh. T¶i träng chØ ®Þnh sÏ ®−îc bao 

b»ng viÒn ®á, trÞ sè ®é lín vµ h−íng cña t¶i träng xuÊt hiÖn trong hép tho¹i Draw 

Line Loads. 

- Söa ®æi nh÷ng néi dung cÇn hiÖu chØnh cña t¶i träng trªn hép tho¹i Draw 

Line Loads. 
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- NhÊn Apply ®Ó cËp nhËt nh÷ng thay ®æi míi cho t¶i träng. 

- §Ó kÕt thóc b−íc hiÖu chØnh, nhÊn chän Done, hoÆc ESC hoÆc phÝm ph¶i 

chuét. 

Chó ý : §Ó nhËp vµ hiÖu chØnh t¶i träng cã thÓ thùc hiÖn tõ thùc ®¬n KeyIn > 

Loads > Line Loads trªn hép tho¹i KeyIn Line Loads nh− h×nh vÏ : 

 

 II.8. Khai b¸o t¶i träng ph©n bè : 

 Khi tÝnh to¸n æn ®Þnh nÒn ®¾p, hoÆc ta luy nÒn ®µo cã nhiÒu tuyÕn ®−êng bã 

trÝ lÖch cao ®é ph¶i kÓ thªm t¶i träng cña «t« hoÆc xe xÝch ch¹y trªn mÆt ®−êng 

b»ng c¸ch ®æi c¸c t¶i träng ®ã vÒ t¶i träng ph©n bè ®Òu trªn c¶ bÒ réng nÒn ®−êng 

cã chiÒu cao ht® x¸c ®Þnh nh− sau :  

     
.
. .td

d

n Gh
B Lγ

=    ; (m) 

 Trong ®ã : 

  n : sè xe nÆng tèi ®a cã thÓ xÕp hµng ngang trong ph¹m vi bÒ réng nÒn 

®−êng. 

  B : BÒ réng hµng xe xÕp hµng ngang nãi trªn; (m) 

  L : ChiÒu dµi xe nÆng tÝnh tõ mÐp tr−íc cña lèp tr−íc ®Õn mÐp sau cña 

lèp sau (m). 

  γ® : Dung träng cña nÒn ®Êt; (T/m3) 

 Tõ ®ã x¸c ®Þnh ®−îc t¶i träng ph©n bè ®Òu : p = γ®.ht® (T/m) 
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 Trªn mµn h×nh ®å ho¹, Ên vµo nót   

xuÊt hiÖn hép tho¹i  

 

 

NhËp tªn ®−êng bao h×nh d¹ng t¶i träng ph©n 

bè (mÆc ®Þnh lµ 1) vµo « nhËp Line #, nÕu vÏ 

nhiÒu t¶i träng kh¸c nhau th× sau mçi lÇn vÏ, ph¶i ®Æt tªn kh¸c (2,3,4 ...)  

NhËp gi¸ trÞ t¶i träng ph©n bè vµo « nhËp Pressure 

NhËp h−íng t¶i träng t¸c dông : th¼ng ®øng (vertical), hoÆc th¼ng gãc nÒn ®Êt 

(normal) 

NhÊn Draw ®Ó vÏ, sau khi vÏ xong nhÊn Done ®Ó kÕt thóc. 

  

II.10. Mét sè tuú chän khi ph¸c th¶o bµi to¸n : 

 II.10.1 §Ó t¾t c¸c ®iÓm hoÆc sè hiÖu c¸c ®iÓm : 

 - Tõ thùc ®¬n View, chän Preferences, hép tho¹i Preferences xuÊt hiÖn : 
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 - §Ó kh«ng hiÓn thÞ ®iÓm trªn b¶n vÏ : bá tuú chän Points. 

 - §Ó kh«ng hiÓn thÞ sè hiÖu ®iÓm hoÆc ®−êng trªn b¶n vÏ : bá tuú chän Point 

& Line Numbers. 

 - Chän OK. 

 II.10.2 VÏ hÖ trôc AXES : 

 ViÖc ph¸c th¶o hÖ trôc trªn b¶n vÏ gióp cho viÖc xem xÐt vµ ®äc th«ng tin 

b¶n vÏ sau khi in trë nªn ®¬n gi¶n h¬n. 

 - BËt chÕ ®é hiÓn thÞ l−íi b»ng c¸ch nhÊn nót chuét vµo nót Snap to Grid 

trªn thanh c«ng cô Grid. 

 - Tõ thùc ®¬n Sketch, chän Axes, hép tho¹i Axes xuÊt hiÖn nh− h×nh vÏ : 

      

 - §Ó t¹o mét hÖ trôc X n»m ngang bªn d−íi vµ Y n»m däc bªn tr¸i : Chän 

Left Axis, Bottom Axis, vµ Axis Numbers trong nhãm Display. 
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 - Chän OK. Con trá chuét sÏ chuyÓn thµnh dÊu +, vµ thanh tr¹ng th¸i xuÊt 

hiÖn th«ng b¸o “Sketch Axes” 

 - DÞch chuyÓn con chuét ®Õn gãc tr¸i bªn tr¸i b¶n vÏ (th−êng lµ ®iÓm cã to¹ 

®é (0,0) ) vµ gi÷ phÝm tr¸i chuét kÐo ®Õn ®iÓm thuéc gãc trªn bªn ph¶i b¶n vÏ vµ 

nh¶ chuét. Mét hÖ trôc x,y sÏ ®−îc t¹o ra trong vïng chän. 

 - §Ó thay ®æi ®é réng kho¶ng c¸ch chia trªn c¸c trôc vµ thay ®æi néi dung 

tiªu ®Ò trªn hÖ trôc : chän Set > Axes. 

 II.10.3 HiÓn thÞ c¸c ®Æc tÝnh cña ®Êt : 

 ViÖc hiÓn thÞ c¸c ®Æc tÝnh cña ®Êt cho phÐp ng−êi thiÕt kÕ cã thÓ kiÓm tra l¹i 

c¸c th«ng sè tÝnh to¸n cña c¸c líp ®Êt ®Ó ®¶m b¶o chóng ®−îc nhËp chÝnh x¸c h¬n. 

§Ó xem c¸c th«ng sè vÒ c¸c líp ®Êt : 

 - Tõ thùc ®¬n View, chän Soil Properties, con trá chuét chuyÓn sang h×nh 

dÊu +, thanh tr¹ng th¸i xuÊt hiÖn th«ng b¸o “View Soil Properties” vµ hép tho¹i 

nh− h×nh vÏ : 

    

 - §Ó xem th«ng sè vÒ líp ®Êt nµo, chØ viÖc di chuyÓn con trá chuét ®Õn bÊt 

cø ®iÓm nµo bªn trong líp ®Êt vµ nhÊn phÝm tr¸i chuét. Líp ®Êt ®−îc t« nÒn l−íi, 

®−êng ph©n c¸ch vµ c¸c ®iÓm ®−îc hiÖn s¸ng. C¸c th«ng sè cña líp ®Êt ®−îc xuÊt 

hiÖn trong hép tho¹i View Soil Properties nh− h×nh vÏ: 
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 Hép tho¹i thÓ hiÖn : sè líp ®Êt, m« t¶ líp ®Êt, lo¹i m« h×nh, c¸c th«ng sè m« 

h×nh (lùc dÝnh, gãc ma s¸t,..), c¸c ®−êng ®o ¸p, ¸p lùc n−íc lç rçng,... 

 - §Ó xem toµn bé th«ng sè cña c¸c líp ®Êt, thay ®æi kÝch th−íc hép tho¹i 

b»ng c¸ch kÐo d·n ®−êng viÒn cña hép tho¹i cho ®Õn khi tÊt c¶ c¸c th«ng tin xuÊt 

hiÖn ®Çy ®ñ. HoÆc nhÊn nót All Soil. Lóc nµy tÊt c¶ c¸c th«ng tin vÒ c¸c líp ®Êt 

hiÓn thÞ nh− hÜnh sau: 

      

 - §Ó chÐp tÊt c¶ c¸c th«ng sè cña ®Êt vµo Clipboard ®Ó d¸n vµo mét øng dông 

kh¸c, chän Copy. 

 - §Ó in tÊt c¶ c¸c th«ng tin vÒ c¸c líp ®Êt, chän Print. 

 - §Ó kÕt thóc, chän Done hoÆc nhÊn phÝm ph¶i chuét. 

 II.10.4 G¸n nh·n (tªn gäi) cho c¸c líp ®Êt : 

 - Tõ thùc ®¬n Sketch, chän Text hép tho¹i Sketch Text xuÊt hiÖn nh− h×nh 

vÏ : 
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 - NhÊn nót Soil, xuÊt hiÖn hép tho¹i : 

 

 - §Ó g¸n nh·n cho líp ®Êt, di chuyÓn con trá chuét ®Õn vÞ trÝ líp ®Êt. NhÊn 

chuét tr¸i ®Ó chän, líp ®Êt nµy sÏ ®−îc t« víi nÒn l−íi, c¸c ®iÓm vµ ®−êng ph©n 

c¸ch líp hiÖn s¸ng. C¸c th«ng sè cña líp ®Êt xuÊt hiÖn trong hép tho¹i víi mÆc 

®Þnh tÊt c¶ c¸c tham sè ®−îc chän. 

 - Muèn hiÓn thÞ c¸c th«ng sè nµo cña líp ®Êt, chän c¸c tham sè trong danh 

s¸ch cña nhãm Soil Properties. NÕu chØ muèn g¸n nh·n cho líp ®Êt, bá chän mäi 

tham sè kh¸c chØ gi÷ l¹i tham sè Description trong nhãm Soil Properties vµ xo¸ néi 

dung trong « Title. 

 - Chän OK ®Ó quay l¹i hép tho¹i Sketch Text. 

 - ViÖc g¸n nh·n cho c¸c líp ®Êt cßn l¹i ®−îc thùc hiÖn t−¬ng tù.  

 - §Ó kÕt thóc viÖc g¸n nh·n nhÊn nót Done, hoÆc nhÊn phÝm ph¶i chuét, hoÆc 

nhÊn ESC. 

 II.10.5. Bæ sung c¸c th«ng tin vÒ bµi to¸n : 

 §Ó bæ sung th«ng tin cho bµi to¸n, c¸c b−íc thùc hiÖn t−¬ng tù nh− g¸n nh·n 

cho c¸c líp ®Êt, trong ®ã viÖc ®Çu tiªn lµ nhËp c¸c th«ng tin vÒ bµi to¸n. Trong 

SLOPE/W, mçi bµi to¸n ®−îc gäi lµ mét dù ¸n (Project). §Ó nhËp c¸c th«ng tin vÒ 

bµi to¸n : 

 - Tõ thùc ®¬n KeyIn, chän Project ID, xuÊt hiÖn hép tho¹i KeyIn Project ID 

nh− h×nh vÏ : 
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 - Trong « Tittle, gâ tiªu ®Ò bµi to¸n (vÝ dô trªn h×nh vÏ SLOPE/W Exemple 

Problem) 

 - Trong « Comments, gâ miªu t¶ bµi to¸n (vÝ dô trªn h×nh vÏ Learn Exemple 

in Chapter 3) 

 - Chän OK. 

 §Ó g¸n nh·n cho bµi to¸n : 

 - Tõ thùc ®¬n Sketch, chän Text, hép tho¹i Sketch Text xuÊt hiÖn nh− h×nh 

vÏ : 

 

 - Chän Project ID, mµn h×nh Project ID xuÊt hiÖn nh− h×nh vÏ : 
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 - Trong danh s¸ch Setting, chän c¸c tham sè cÇn ®−a vµo bµi to¸n (mÆc ®Þnh 

tÊt c¶ c¸c tham sè ®−îc chän).  

 - TiÕn hµnh chän tõng c¸c tham sè ®−îc chän trong danh s¸ch Setting vµ 

thùc hiÖn xo¸ néi dung trong « Title. Sau khi hoµn tÊt c¸c b−íc thùc hiÖn, mang 

h×nh Project ID cã d¹ng nh− h×nh vÏ : 

    

 - §Ó ®Æt nh·n cho bµi to¸n, nhÊn phÝm tr¸i chuét t¹i vÞ trÝ cÇn thÓ hiÖn trªn 

b¶n vÏ. 

 - Chän Done ®Ó kÕt thóc viÖc bæ sung th«ng tin cho bµi to¸n. 

 Chó ý : NÕu thay ®æi th«ng tin vÒ bµi to¸n, nh·n sÏ tù ®éng cËp nhËt. NÕu 

muèn hiÓn thÞ nhiÒu th«ng tin h¬n vÒ bµi to¸n trªn nh·n, chän Modify > Text vµ 

nhÊn vµo nh·n cña bµi to¸n. 

 Sau khi hoµn thµnh c¸c b−íc ®· nÕu, mµn h×nh cã d¹ng nh− h×nh vÏ : 
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II.10.6 ChÌn ¶nh vµo b¶n vÏ : 

§Ó chÌn ¶nh vµo b¶n vÏ (vÝ dô biÓu t−îng cña c«ng ty hay bÊt kú lo¹i ¶nh 

nµo), qu¸ tr×nh thao t¸c ®−îc thùc hiÖn nh− sau : 

- Khëi ®éng DEFINE vµ më tÖp b¶n vÏ cÇn chÌn ¶nh. 

- Tõ thùc ®¬n File, chän Import Picture, hép tho¹i Import Picture xuÊt hiÖn 

: 

 

- Chän file ¶nh cÇn chÌn (vÝ dô HighFive.bmp), nhÊn Open. Con trá sÏ 

chuyÓn thµnh dÊu +. 
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- Di chuyÓn con trá ®Õn vÞ trÝ cÇn chÌn ¶nh trªn b¶n vÏ vµ nhÊn chuét tr¸i. 

Sau khi chÌn mµn h×nh cã d¹ng nh− h×nh vÏ : 

 

II.10.7 Thay ®æi kÝch th−íc vµ vÞ trÝ ¶nh : 

- Chän Modify > Objects. Sau khi chän con trá chuyÓn sang mòi tªn mµu 

®en. 

- NhÊn chuét lªn vÞ trÝ ¶nh vµ di chuyÓn ¶nh ®Õn vÞ trÝ cÇn thay ®æi. 

- NhÊn Done hoÆc ESC ®Ó kÕt thóc. 

 

III. Ph©n tÝch bµi to¸n : 

 III.1 KiÓm tra d÷ liÖu ®· nhËp : 

 Sau khi ®· ph¸c th¶o bµi to¸n, tiÕn hµnh kiÓm tra l¹i c¸c d÷ liÖu ®· nhËp ®Ó 

®¶m b¶o d÷ liÖu ®−îc nhËp chÝnh x¸c. 

 -Tõ thôc ®¬n Tools, chän Verify, xuÊt hiÖn hép tho¹i Verify Data nh− h×nh 

vÏ : 
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 - NhÊp chän Verify : SLOPE/W sÏ kiÓm tra d÷ liÖu bµi to¸n. NÕu ph¸t hiÖn 

lçi trong d÷ liÖu, c¸c th«ng b¸o lçi sÏ xuÊt hiÖn trong hép tho¹i nh− h×nh vÏ, trong 

®ã tæng sè lçi sÏ xuÊt hiÖn ë dßng cuèi cïng. 

           

 

 - NhÊp Done ®Ó ®ãng hép tho¹i. 

 III.2 L−u d÷ liÖu ®· nhËp : 

 Sau khi kiÓm tra d÷ liÖu ®· nhËp. Chän File > Save ®Ó l−u d÷ liÖu. 

SLOPE/W SOLVE sÏ l−u tÖp d÷ liÖu víi ®u«i tÖp *.SLP vµ sö dông tÖp d÷ liÖu nµy 

®Ó tÝnh hÖ sè an toµn. 

III.3 Ph©n tÝch bµi to¸n : 

- Trªn thanh c«ng cô DEFINE, nhÊn chuét lªn nót SOLVE 
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 HoÆc tõ thùc ®¬n Tools chän Solve, hép tho¹i Slope/W Solve xuÊt hiÖn nh− 

h×nh vÏ. Chän File > Open Data File tõ hép tho¹i Slope/W Solve ®Ó më tÖp cÇn 

tÝnh to¸n. 

          Cöa sæ SOLVE xuÊt hiÖn. SOLVE sÏ tù ®éng më tÖp *.SLP cÇn tÝnh to¸n vµ 

hiÓn thÞ tªn tÖp, nh− h×nh vÏ (ë ®©y tªn tÖp lµ Learn.slp) 

                

 - NhÊn chuét lªn nót Start cña cöa sæ Solve. Sau khi chän, mét chÊm mµu 

xanh xuÊt hiÖn gi÷a nót Start vµ Stop. ChÊm nµy nhÊp nh¸y trong khi bµi to¸n ®−îc 

gi¶i. 

- NhÊp chän File > Exit ®Ó tho¸t khái cöa sæ SLOPE/W SOLVE. 

 Trong qu¸ tr×nh ph©n tÝch, SOLVE hiÓn thÞ hÖ sè an toµn tèi thiÓu vµ sè hiÖu 

mÆt tr−ît hiÖn t¹i ®ang ph©n tÝch, nh− h×nh vÏ : 
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 III.4 Xem kÕt qu¶ tÝnh to¸n : 

 KÕt qu¶ ph©n tÝch, cã thÓ ®−îc xem b»ng ®å ho¹ th«ng qua ch−¬ng tr×nh 

SLOPE/W CONTOUR.§Ó khëi ®éng CONTOUR, nhÊn nót CONTOUR trªn thanh 

c«ng cô DEFINE 

               

 HoÆc cã thÓ ch¹y CONTOUR tõ thùc ®¬n Tools chän CONTOUR, hép tho¹i 

SLOPE/W CONTOUR xuÊt hiÖn nh− h×nh vÏ. Chän File > Open  tõ hép tho¹i 

SLOPE/W CONTOUR ®Ó më tÖp cÇn xem kÕt qu¶ ph©n tÝch.                    
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 B¶n vÏ cña CONTOUR sÏ ®−îc thÓ hiÖn theo nh÷ng lùa chän trong View, 

Preferences khi ghi bµi to¸n ®−îc ®Þnh nghÜa b»ng DEFINE. Trong ®ã, cã thÓ xem 

c¸c phÇn kh¸c b»ng c¸ch thay ®æi Preferences tõ thùc ®¬n View cña CONTOUR. 

 III.4.1 VÏ mét mÆt tr−ît bÊt kú : 

 §Ó vÏ mÆt tr−ît bÊt kú kh«ng ph¶i lµ mÆt tr−ît cã hÖ sè an toµn tèi thiÓu : 

 - Tõ thùc ®¬n Draw cña CONTOUR chän Slip Surfaces, xuÊt hiÖn hép tho¹i 

nh− h×nh vÏ : 

 

 Hép tho¹i cung cÊp th«ng tin vÒ mÆt tr−ît hiÖn t¹i ®ang hiÓn thÞ vµ danh s¸ch 

c¸c mÆt tr−ît vµ hÖ sè an toµn t−¬ng øng. 

 - §Ó hiÓn thÞ c¸c mÆt tr−ît kh¸c, di chuyÓn chuét trªn cöa sæ CONTOUR gÇn 

l−íi t©m quay cña mÆt tr−ît cÇn thÓ hiÖn vµ nhÊn phÝm tr¸i. CONTOUR vÏ mÆt 

tr−ît nhá nhÊt cho t©m quay nµy vµ hiÓn thÞ hÖ sè an toµn bªn trong l−íi c¸c t©m 

®iÓm. 

 - §Ó kÕt thóc, nhÊn Done hoÆc phÝm ph¶i chuét. 

 III.4.2 HiÓn thÞ kÕt qu¶ theo c¸c ph−¬ng ph¸p tÝnh kh¸c : 

 Trong phÇn khai b¸o ph¸c th¶o bµi to¸n, viÖc tÝnh to¸n hÖ sè an toµn ®−îc 

chän theo ph−¬ng ph¸p Bishop (with Ordinary and Janbu), v× thÕ CONTOUR hiÓn 

thÞ hÖ sè an toµn theo ph−¬ng ph¸p Bishop. C¸c hÖ sè an toµn theo ph−¬ng ph¸p 

Ordinary vµ Janbu còng cã thÓ ®−îc xem. §Ó xem hÖ sè an toµn theo c¸c ph−¬ng 

ph¸p kh¸c : 

 - Tõ thùc ®¬n View, chän Method, xuÊt hiÖn hép tho¹i View Method : 
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 - BÊm mòi tªn bªn ph¶i hép tho¹i danh s¸ch c¸c ph−¬ng ph¸p kh¸c xuÊt 

hiÖn. Muèn hiÓn thÞ kÕt qu¶ theo ph−¬ng ph¸p nµo, chän tõ hép danh s¸ch th¶ 

xuèng. 

 

 - Chän OK. 

 §Ó trë vÒ chÕ ®é xem mÆc ®Þnh. Chän View > Method vµ chän Bishop hoÆc 

nhÊn nót Default trªn thanh c«ng cô Method. 

    

III.4.3 HiÓn thÞ lùc t¸c dông trªn tõng ph©n tè : 

- Tõ thùc ®¬n View, chän Slice Forces : Mét cöa sæ trèng xuÊt hiÖn, con trá 

chuét chuyÓn tõ h×nh mòi tªn sang h×nh dÊu +, thanh tr¹ng th¸i xuÊt hiÖn th«ng b¸o 

“View Slice Forces” 

- §Ó xem s¬ ®å lùc t¸c dông trªn ph©n tè ®Êt nµo, di chuyÓn chuét bªn trong 

ph©n tè ®ã vµ nhÊn chuét tr¸i. KÕt qu¶ lùc t¸c dông lªn mçi ph©n tè ®Êt nh− h×nh vÏ 

: 
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S¬ ®å hiÓn thÞ c¸c lùc t¸c dông lªn ph©n tè ®Êt ®−îc chän ®èi víi ph−¬ng 

ph¸p tÝnh hiÖn t¹i trªn mÆt tr−ît tèi thiÓu. §é lín cña mçi vect¬ lùc ®−îc hiÓn thÞ 

bªn c¹nh mòi tªn vµ h−íng cña mòi tªn chØ h−íng cña vect¬. §a gi¸c lùc miªu t¶ 

tæng hîp tÊt c¶ c¸c lùc t¸c dông lªn ph©n tè ®Êt. §a gi¸c lùc khÐp kÝn thÓ hiÖn sù 

c©n b»ng cña lùc t¸c dông lªn ph©n tè ®Êt. 

C¸c lùc t¸c dông lªn mçi ph©n tè ®Êt cña mÆt tr−ît nguy hiÓm nhÊt ®−îc tÝnh 

vµ l−u trong tÖp cã phÇn më réng *.FRC. 

- §Ó sao chÐp ®å thÞ vµo Clipboard d¸n vµo øng dông kh¸c, chän Copy 

Diagram. 

 - §Ó sao chÐp th«ng tin theo ®Þnh d¹ng text, chän Copy Data 

 - §Ó in h×nh vÏ, chän Print 

 - Chän Done hoÆc nhÊn phÝm ph¶i ®Ó kÕt thóc. 

III.4.4 VÏ ®−êng chu tuyÕn cña c¸c hÖ sè an toµn (®−êng ®¼ng Kat) : 

 - Tõ thùc ®¬n Draw, chän Contours, xuÊt hiÖn hép tho¹i Draw Contours 

nh− h×nh vÏ : 
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 Nhãm Data Range hiÓn thÞ gi¸ trÞ hÖ sè an toµn lín nhÊt vµ nhá nhÊt cho 

ph−¬ng ph¸p tÝnh hiÖn t¹i. C¸c gi¸ trÞ mÆc ®Þnh cña chu tuyÕn ®−îc hiÓn thÞ trong 

nhãm Contour Range. 

 - §Ó thay ®æi ®−êng chu tuyÕn, nhËp gi¸ trÞ míi trong « Increment by vµ 

Number of Contours trong nhãm Contour Range. 

 - NhÊn Apply ®Ó thùc hiÖn lÖnh vÏ theo c¸c gi¸ trÞ míi. 
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 - NhÊn OK ®Ó kÕt thóc. 

III.4.5 BiÔu diÔn kÕt qu¶ trªn ®å thÞ : 

§Ó xem kÕt qu¶ ph©n tÝch trªn ®å thÞ : 

- Tõ thùc ®¬n Draw, chän Graph, hép tho¹i Draw Graph xuÊt hiÖn nh− h×nh 

vÏ : 

 

 Mµn h×nh Graph ®ång thêi ®−îc hiÓn thÞ, bao gåm mét ®å thÞ cho c¸c ®iÒu 

kiÖn ®−îc chän nh− h×nh vÏ : 
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 - Muèn vÏ ®å thÞ theo ®iÒu kiÖn nµo, nhÊp mòi tªn bªn ph¶i danh s¸ch ®Ó 

chän. 

 - §Ó in ®å thÞ, chän File > Print trong cöa sæ Graph. 

 - §Ó sao chÐp ®å thÞ vµo Clipboard d¸n vµo øng dông kh¸c, chän Edit > 

Copy 

 - §Ó x¸c ®Þnh c¸c tuú chän khi vÏ ®å thÞ, chän Set > Option, hép tho¹i 

Graph Options xuÊt hiÖn nh− h×nh vÏ : 
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 - §Ó ®ãng cöa sæ Graph, nh¾p ®óp chuét vµo control-menu bªn gãc tr¸i hoÆc 

chän Done tõ Draw Graph. 

III.5 In b¶n vÏ : 

- Tr−íc khi in, ph¶i ®¶m b¶o toµn bé b¶n vÏ ph¶i n»m trong cöa sæ. §Ó hiÓn 

thÞ toµn bé b¶n vÏ, nhÊn chuét lªn nót Zoom Objects trªn thanh c«ng cô Zoom 

(NÕu thanh c«ng cô Zoom kh«ng xuÊt hiÖn, chän View > Toolbars > Zoom). 

- NhÊn chän Print, hép tho¹i Print xuÊt hiÖn nh− h×nh vÏ : 

 

 - Chän OK ®Ó in b¶n vÏ ra m¸y in víi c¸c kÝch th−íc mÆc ®Þnh. 

 

 IV. Ph©n tÝch x¸c suÊt : 

 Qu¸ tr×nh ph©n tÝch ®é æn ®Þnh ®Ó x¸c ®Þnh hÖ sè an toµn ®· tr×nh bµy trªn 

dùa trªn mét tËp hîp c¸c ®iÒu kiÖn vµ tham sè vËt liÖu cè ®Þnh. Thùc tÕ, ®iÒu nµy 

kh«ng hoµn toµn chÝnh x¸c (c¸c ®iÒu kiÖn vµ tham sè vËt liÖu lµ kh«ng hoµn toµn 

cè ®Þnh), chøc n¨ng ph©n tÝch x¸c suÊt cña SLOPE/W cho phÐp ta quan t©m ®Õn 

nhiÒu lo¹i tham sè ®Çu vµo kh¸c nhau, bao gåm c¶ d÷ liÖu vÒ líp ®Êt. 

 Môc tiªu cña viÖc ph©n tÝch x¸c suÊt nh»m x¸c ®Þnh x¸c suÊt ph¸ ho¹i m¸i 

dèc hay x¸c suÊt æn ®Þnh cña m¸i dèc. §©y lµ ®iÒu mµ ph−¬ng ph¸p ph©n tÝch ®· 

tr×nh bµy ë trªn kh«ng thÓ gi¶i quyÕt ®−îc. 
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 SLOPE/W thùc hiÖn ph©n tÝch x¸c suÊt b»ng ph−¬ng ph¸p Monte Carlo. 

  

IV.1 Chän ph−¬ng ph¸p ph©n tÝch : 

§Ó chØ ra ph−¬ng ph¸p ph©n tÝch, trong DEFINE : 

 - Tõ thùc ®¬n KeyIn, chän Analysis Control, hép tho¹i KeyIn Analysis 

Control xuÊt hiÖn nh− h×nh vÏ : 

   

 - Chän ph−¬ng ph¸p ph©n tÝch x¸c suÊt Apply Probabilistic Analysis 

 - NhËp sè phÐp thö trong « Monte Carlo Trials 

 - NhËp trÞ sè ®é lÖch Std. Deviation trong nhãm Pore-Water Pressure lµ 1.  

C¸c gi¸ trÞ cßn l¹i vÉn gi÷ nguyªn kh«ng thay ®æi. 

- Chän OK. 

IV.2 NhËp ®é lÖch chuÈn cho c¸c th«ng sè cña c¸c líp ®Êt : 

- Tõ thùc ®¬n KeyIn, chän Soil Properties, hép tho¹i KeyIn Soil Properties 

xuÊt hiÖn nh− h×nh vÏ : 
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 - TiÕn hµnh chän lÇn l−ît tõng líp ®Êt vµ nhËp c¸c gi¸ trÞ vµ ®é lÖch chuÈn 

cho c¸c th«ng sè Unit Weight, Phi, Cohesion. 

 - Sau khi ®· nhËp xong cho mçi líp ®Êt, nhÊn chän Copy ®Ó cËp nhËt thay 

®æi. 

 - Chän OK. 

 - L−u tÖp d÷ liÖu võa cËp nhËt. Chän SaveAs ®Ó l−u thµnh tªn míi. 

   

 



Tr−êng §HBK - Bé m«n §−êng «t« & §−êng thµnh phè  43 

H−íng dÉn sö dông phÇn mÒm kiÓm tra æn ®Þnh m¸i dèc Slope/W  

IV.3. Thùc hiÖn ph©n tÝch x¸c suÊt : 

- Khëi ®éng SOLVE b»ng c¸ch nhÊn nót Solve trªn thanh c«ng cô (xem môc 

1.3.3). 

- NhÊn nót START trªn cöa sæ SOLVE. 

KÕt thóc ph©n tÝch, hÖ sè an toµn trung b×nh t¹i mÆt tr−ît nguy hiÓm nhÊt 

hiÓn thÞ cho c¸c ph−¬ng ph¸p kh¸c nhau, nh− h×nh vÏ : 

    

 Chó ý : HÖ sè an toµn trung b×nh sÏ kh¸c nhau mçi khi tiÕn hµnh ch¹y l¹i 

SOLVE. Gi¸ trÞ thay ®æi phô thuéc vµo c¸c tham sè ®Çu vµo, sè lÇn thö Monte 

Carlo. NÕu hÖ sè an toµn kh¸c nhau nhiÒu mçi khi ph©n tÝch, cã thÓ t¨ng sè phÐp 

thö lªn. 

IV.4 Xem kÕt qu¶ ph©n tÝch x¸c suÊt : 

- Khëi ®éng CONTOUR b»ng c¸ch nhÊn nót Contour trªn thanh c«ng cô 

(xem môc 1.3.4). 

- Cöa sæ CONTOUR xuÊt hiÖn sÏ tù ®éng më tÖp cÇn tÝnh to¸n. KÕt qu¶ tÝnh 

to¸n ®−îc thÓ hiÖn nh− h×nh vÏ : 

 Chó ý : HÖ sè an toµn trªn l−íi t©m ®iÓm lu«n lµ hÖ sè an toµn nhá nhÊt sö 

dông gi¸ trÞ trung b×nh cña sè liÖu ®Çu vµo. Nã kh«ng ph¶i lµ hÖ sè an toµn trung 

b×nh cña c¸c phÐp thö Monte Carlo. 
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IV.5 VÏ ®å thÞ kÕt qu¶ ph©n tÝch x¸c suÊt : 

- Tõ thùc ®¬n Draw, chän Probability, hép tho¹i Draw Probability xuÊt hiÖn 

: 

    

MÆc ®Þnh, ®å thÞ hµm mËt ®é x¸c suÊt (Probability Density Function) vµ biÓu 

®å hÖ sè an toµn cïng ®−îc hiÓn thÞ víi sè líp mÆc ®Þnh lµ 20 : 

- Trong « # of classe thay ®æi sè líp thµnh 40 vµ nhÊn Refresh, ®å thÞ ®−îc 

cËp nhËt nh− h×nh vÏ : 
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 Trôc Frequency (%) dïng ®Ó chØ hÖ sè an toµn theo phÐp thö Monte Carlo. 

 - §Ó xem hµm ph©n bè x¸c suÊt, nhÊn nót Distribution Function trong hép 

tho¹i Draw Probability, hµm ph©n bè x¸c suÊt xuÊt hiÖn nh− h×nh vÏ : 
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 §©y lµ hµm chØ ra ph©n bè x¸c suÊt cña c¸c hÖ sè an toµn nhá h¬n mét hÖ sè 

an toµn nhÊt ®Þnh. §−êng chÊm ®á chØ ra x¸c suÊt mµ hÖ sè an toµn nhá h¬n 1 (hay 

x¸c suÊt ph¸ ho¹i). 

 Hµm ph©n bè x¸c suÊt víi hÖ sè an toµn lín h¬n mét gi¸ trÞ nhÊt ®Þnh cã thÓ 

xem b»ng c¸ch nhÊn chän nót t−¬ng øng trong nhãm Distriction Function trong 

hép tho¹i Draw Probability. 

    

 - §Ó xem c¸c gi¸ trÞ kh¸c cña x¸c suÊt nh− gi¸ trÞ trung b×nh cña hÖ sè an 

toµn, chØ sè tin cËy, x¸c suÊt ph¸ ho¹i. Chän nót Data<< tõ hép tho¹i Draw 

Probability. 

- §Ó chÐp ®å thÞ vµo Cilboard nh»m môc ®Ých d¸n vµo øng dông kh¸c, chän 

Edit > Copy. 

- §Ó in ®å thÞ, chän File > Print tõ cña sæ Graph. 

- §Ó ®ãng cöa sæ d÷ liÖu x¸c suÊt vµ cöa sæ vÏ ®å thÞ, chän Done. 
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Sau khi ch¹y ch−¬ng tr×nh, kÕt qu¶ sÏ ®−îc hÖ sè æn ®Þnh theo c¸c ph−¬ng 

ph¸p ph©n tÝch ë trang Solve vµ h×nh d¹ng mÆt tr−ît víi c¸c th«ng sè nh− b¸n kÝnh 

cung tr−ît trßn, to¹ ®é t©m tr−ît,... Cã thÓ xem thªm chi tiÕt hoÆc kÕt xuÊt sè liÖu 

d¹ng b¶ng ë c¸c file *.slp, *.fac, *.sl2, *.frc, ®−îc sinh ra khi ch¹y ch−¬ng tr×nh :  
---------------------------------------- 

 | SUMMARY OF MINIMUM FACTORS OF SAFETY | 

 ---------------------------------------- 

 MOMENT EQUILIBRIUM: FELLENIUS OR ORDINARY METHOD 

      36.7857=X-COOR.     29.5000=Y-COOR.     25.0000=RADIUS      1.286=F.S.   301=SLIP# 

 MOMENT EQUILIBRIUM: BISHOP SIMPLIFIED METHOD 

      36.7857=X-COOR.     29.5000=Y-COOR.     25.0000=RADIUS      1.331=F.S.   301=SLIP# 

 FORCE EQUILIBRIUM: JANBU SIMPLIFIED METHOD (NO fo FACTOR) 

      36.5000=X-COOR.     28.0714=Y-COOR.     23.5714=RADIUS      1.220=F.S.   261=SLIP# 

  

 NORMAL TERMINATION OF SLOPE 

C¸c th«ng sè vÒ mÆt tr−ît 

Center_X       Center_Y       Radius         Slip_Surface   Method 

============================================================================== 

     3.678571e+001  2.950000e+001  2.500000e+001     301         1 

  

SL#  X_Left         Y_L_Top        Y_L_Bottom     X_Right        Y_R_Top        Y_R_Bottom     Mid_Height 

=====================================================================================

======================= 

  1  1.366105e+001  2.000000e+001  2.000000e+001  1.449579e+001  2.000000e+001  1.817926e+001  9.584332e-

001 

  2  1.449579e+001  2.000000e+001  1.817926e+001  1.533053e+001  2.000000e+001  1.666743e+001  

2.607491e+000 
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  3  1.533053e+001  2.000000e+001  1.666743e+001  1.616526e+001  2.000000e+001  1.536504e+001  

4.005933e+000 

  4  1.616526e+001  2.000000e+001  1.536504e+001  1.700000e+001  2.000000e+001  1.421846e+001  

5.225336e+000 

  5  1.700000e+001  2.000000e+001  1.421846e+001  1.796607e+001  2.000000e+001  1.304336e+001  

6.387311e+000 

  6  1.796607e+001  2.000000e+001  1.304336e+001  1.893214e+001  2.000000e+001  1.200000e+001  

7.493202e+000 

 

SL#  L_Load_X     L_Load_Y     A_Load_X     A_Load_Y     P_Load_X     P_Load_Y     A_Modifier 

=====================================================================================

========= 

  1  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 -1.6102e-007 -1.2062e+001  1.0000e+000 

  2  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 -1.6102e-007 -1.2062e+001  1.0000e+000 

  3  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 -1.6102e-007 -1.2062e+001  1.0000e+000 

  4  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 -1.6102e-007 -1.2062e+001  1.0000e+000 

  5  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  1.0000e+000 

  6  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  1.0000e+000 

  7  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  1.0000e+000 

 

SL#  Weight       Pore_Water   Alpha        Force Fn.    Seismic_F    Seismic_Y    Pore_Air     Phi_B  

=====================================================================================

====================== 

  1  1.3601e+001  0.0000e+000  6.5370e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  2  3.7002e+001  0.0000e+000  6.1095e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  3  5.6846e+001  0.0000e+000  5.7343e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  4  7.4150e+001  0.0000e+000  5.3945e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  5  1.0490e+002  0.0000e+000  5.0576e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  6  1.2306e+002  0.0000e+000  4.7203e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

  7  1.5595e+002  9.2320e+000  4.3875e+001  1.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000  0.0000e+000 

C¸c th«ng sè theo ph−¬ng ph¸p ph©n tÝch : 

Bishop_Method_Fm=  1.331       Applied_Lambda=  0.0000 

SL#  Normal_M     ShearMob     Phi_Angle    Cohesion     SideLeft     ShearLeft    SideRight    ShearRight 

=====================================================================================

====================== 

  1  7.7464e+000 -2.4703e+001  2.0000e+001  1.5000e+001  0.0000e+000  0.0000e+000  6.1706e+000  0.0000e+000 

  2  4.4334e+001 -3.1597e+001  2.0000e+001  1.5000e+001 -6.1706e+000  0.0000e+000 -1.3867e+001  0.0000e+000 

  3  7.0470e+001 -3.6716e+001  2.0000e+001  1.5000e+001  1.3867e+001  0.0000e+000 -4.9502e+001  0.0000e+000 

  4  9.0549e+001 -4.0757e+001  2.0000e+001  1.5000e+001  4.9502e+001  0.0000e+000 -9.4559e+001  0.0000e+000 

  5  1.0833e+002 -4.6782e+001  2.0000e+001  1.5000e+001  9.4559e+001  0.0000e+000 -1.4390e+002  0.0000e+000 

  6  1.2650e+002 -5.0632e+001  2.0000e+001  1.5000e+001  1.4390e+002  0.0000e+000 -1.9743e+002  0.0000e+000 

  7  1.2985e+002 -9.0045e+001  3.2000e+001  3.0000e+001  1.9743e+002  0.0000e+000 -2.1501e+002  0.0000e+000 

 

Janbu_Method_Ff=  1.222        Applied_Lambda=  0.0000 

SL#  Normal_F     ShearMob     Phi_Angle    Cohesion     SideLeft     ShearLeft    SideRight    ShearRight 

=====================================================================================

====================== 

  1  4.6597e+000 -2.5987e+001  2.0000e+001  1.5000e+001  0.0000e+000  0.0000e+000  6.1706e+000  0.0000e+000 

  2  4.0820e+001 -3.3369e+001  2.0000e+001  1.5000e+001 -6.1706e+000  0.0000e+000 -1.3867e+001  0.0000e+000 
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  3  6.6773e+001 -3.8889e+001  2.0000e+001  1.5000e+001  1.3867e+001  0.0000e+000 -4.9502e+001  0.0000e+000 

  4  8.6793e+001 -4.3273e+001  2.0000e+001  1.5000e+001  4.9502e+001  0.0000e+000 -9.4559e+001  0.0000e+000 

  5  1.0438e+002 -4.9778e+001  2.0000e+001  1.5000e+001  9.4559e+001  0.0000e+000 -1.4390e+002  0.0000e+000 

  6  1.2259e+002 -5.3983e+001  2.0000e+001  1.5000e+001  1.4390e+002  0.0000e+000 -1.9743e+002  0.0000e+000 

  7  1.2437e+002 -9.5270e+001  3.2000e+001  3.0000e+001  1.9743e+002  0.0000e+000 -2.1501e+002  0.0000e+000 

 

B. m¸I DèC CHÌN CèT : 

Tr−êng hîp m¸i dèc ®−îc ®¸nh gi¸ mÊt æn ®Þnh 

(vÝ dô víi ph−¬ng ph¸p Bishop lµ K«® <1,4) th× tiÕn 

hµnh gia c−êng m¸i dèc, cã rÊt nhiÒu ph−¬ng ph¸p, kü 

thuËt t¨ng c−êng tÝnh æn ®Þnh m¸i dèc ( Xem l¹i c¸c 

kiÕn thøc ®· häc vµ tµi liÖu liªn quan), ë ®©y giíi thiÖu 

ph−¬ng ph¸p chÌn cèt mµ ch−¬ng tr×nh cã thÓ tÝnh 

to¸n ®−îc. 

Tõ mµn h×nh ®å ho¹ Define nhÊp chän   hoÆc vµo menu Draw > Anchor 

loads, xuÊt hiÖn hép nhËp  nh− h×nh bªn. 

Tr−êng hîp dïng neo øng suÊt tr−íc ( hiÖn nay Bé GTVT ®ang triÓn khai 

dïng thö nghiÖm neo OVM ) th× t¹i « nhËp Max. Magnitude nhËp vµo t¶i øng suÊt 

tr−íc, L−u ý r»ng gi¸ trÞ cña t¶i øng suÊt tr−íc kh«ng lín h¬n søc chèng nhæ gi÷a 

®Êt vµ cèt ( xem BS. 8001-95 - æn ®Þnh néi bé) 

¤ nhËp Apply Magnitude  nªn chän lµ Variable, tøc lµ nÕu cã phÇn bÇu neo 

n»m trong vïng bÞ ®éng cña m¸i dèc th× kh«ng xÐt ®Õn ¶nh h−ëng phÇn nµy. 

Total Length : nhËp tæng chiÒu dµi neo 

Bonded Length : nhËp chiÒu dµi bÇu neo 

Direction : nhËp gãc neo so víi ph−¬ng n»m ngang 
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Cã thÓ nhÊp chän ®iÓm ®Çu vµ ®iÓm cuèi neo trªn mµn h×nh ®å ho¹ ®Ó x¸c 

®Þnh vÞ trÝ, chiÒu dµi neo  

Muèn di chuyÓn, xo¸ bá vÞ trÝ ®Æt neo, chän nót  hoÆc Modify > Object 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sau khi hoµn tÊt viÖc thiÕt kÕ neo, tiÕn hµnh ch¹y ch−¬ng tr×nh theo c¸c b−íc 

nh− ë phÇn A ®Ó x¸c ®Þnh l¹i hÖ sè æn ®Þnh míi, ®¸nh gi¸ møc ®é æn ®Þnh cña m¸i 

dèc sau khi chÌn neo. 

C. vÝ dô tÝnh to¸n : 

Xö lý tr−ît m¸i taluy trªn ®−êng Hå ChÝ Minh ®o¹n Km551+630 - 
Km551+810 

 
* Sè liÖu ®Þa chÊt : 
 
+ Líp 1 : ®Êt sÐt pha lÉn d¨m s¹n 
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 C=15 kPa, ϕ = 20o, γ = 17 kN/m3 , ka = 5.104 kN/m3, k t= 7.104 kN/m3 
+ Líp 2 : ®¸ c¸t kÕt phong ho¸ nÆng 
 C=30 kPa, ϕ = 32o, γ = 19 kN/m3 , ka = 2.105 kN/m3, k t= 4.105 kN/m3 
+ ChiÒu cao m¸i dèc H = 15 m, ®é dèc 1: 0,25, cø 5m giËt cÊp 2m  

 
 TiÕn hµnh ph¸c ho¹ bµi to¸n thÓ hiÖn nh− ë h×nh d−íi : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

HÖ sè æn ®Þnh m¸i dèc tÝnh theo ph−¬ng ph¸p Bishop lµ 
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Sau khi gia c−êng neo, ch¹y ch−¬ng tr×nh tÝnh ®−îc hÖ sè æn ®Þnh míi lµ 
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